
Psi Encyclopedia Style Guide
 

This style guide is provided as a reference for contributors to the Psi Encyclopedia.
We describe the intended purpose and orientation of the work and specify rules for
language and formatting in the text, the literature list and the endnotes. All new
contributions from February 2021 onwards should adhere to these rules. Existing
articles will be updated over time to conform to them.

Preface

Purpose of the Psi Encyclopedia

The primary aim of the Psi Encyclopedia (hereafter, PE) is to open a window onto
the research literature of psychical research and parapsychology  in the form of
objective, fact-filled and in-depth summaries. Writing should be scholarly and yet
accessible to a wide general readership. Secondary aims are to demonstrate that
scientific and scholarly investigations have been carried out into an array of psychic
phenomena, that the research is wide-ranging and credible, and that there is good
reason for supposing these phenomena to be genuine.

Article Structure

PE articles have a uniform structure, beginning with a brief introductory paragraph,
then a table of contents, followed by the body of the text concluding with a by-line,
a literature list and endnotes to the text (which include citations and are headed
References on the published page). On the published page, a right-hand column
contains summary information about the article and may present associated
illustrations. An illustration typically accompanies the introductory paragraph as
well.

General Guidelines

Article topics, titles and lengths are assigned by the PE Editor, who will also write
or edit the introductory paragraph. The table of contents is automatically
generated from headings in the article body. Authors are responsible for the article
body, the literature list and the endnotes, although they may suggest a title and
draft the introductory paragraph. Detailed rules for these sections follow this
preface. This section provides general guidance on approach and writing style.

The PE is intended as an introduction and overview of research that has been
conducted in psychical research and parapsychology, rather than the paranormal or
the occult as conceived by the public. You should fully describe psi phenomena as
they appear in their natural setting and in the laboratory; however, be sure to
emphasise the scientific and investigative aspects wherever possible. Your writing
should be impersonal. If you contribute to the area about which you are writing,
you will need to include your own research findings and ideas, but cite yourself in
third person and ensure that all views on the topic are represented fairly.



The purpose of a PE article is not primarily to persuade or entertain, rather to
educate and inform. Focus on facts – on the background, the key studies, the
controversies, the contesting viewpoints. Think of your article as a detailed
snapshot. A PE article, ideally, should be sober and factual, but less verbally dense
and containing less technical language than a scholarly paper, so as to engage the
average reader. Use gender-neutral language as much as possible; avoid words such
as ‘man’ and ‘mankind’ and universal masculine pronouns.

Case studies help enliven your writing, so use them liberally. Use at least some fine
detail in longer case studies, even though you will need to summarize much.
Quotations, both short and long, that add to the impact of your writing are
encouraged. Consider using bulleted lists for series of related points. Supply
embedded hyperlinks to other PE articles and outside web pages whenever you can,
in order to lead the reader to additional information on your topic.

Bear in mind that sceptics likely will see the PE as a challenge and may seek to
undermine your article. To help pre-empt this, ensure that their key positions are
mentioned where relevant, perhaps in a dedicated section. If appropriate, entitle
this section  ‘Criticisms and Controversy’. Rebuttals should be based on evidence,
not authorial comment; reference to existing discussions rather than original
argumentation is preferred. Avoid rhetoric and polemics.

Rights and Conditions

Authors agree to contribute only original and previously unpublished work
for publication in the PE, unless under arrangement with the Editor.
Authors agree to transfer rights over their articles to the Society for Psychical
Research, publisher of the PE.
Quotations of copyrighted material from other sources is governed by the
concept of ‘fair dealing’ under sections 29 and 30 of the Copyright, Designs
and Patents Act 1988 (UK), which allows for the reproduction of brief
passages with appropriate acknowledgement.
Authors take full responsibility for the content and views expressed in their
contribution. If disputes arise, they will be adjudicated by the Editor, whose
decisions will be considered final.
Authors agree to have their articles edited.
Authors have permission to republish their articles, in part or in full, in other
venues, provided they properly credit the PE as their source.
By submitting your article to the PE, you agree to these conditions.

Submission, Editing and Approval

Completed articles should be emailed to the Editor. Articles composed in any word
processing programme are acceptable, but they should be formatted in 11-point
Times New Roman in block text, with single line spacing. Do not double-space
between sentences. Insert a blank line  between paragraphs. Do not use italics,
boldface or larger point sizes to indicate headings and subheadings. Instead, offset
them with blank lines above and below.

https://www.bl.uk/business-and-ip-centre/articles/fair-use-copyright-explained


Optionally, you may provide a table of contents at the head of your article as a
guide to the Editor, although this will be removed and the headings will be
generated  automatically by the site software. If there are discrepancies between
wording in your table of contents and the headings in the body of the article, the
latter will determine how the table of contents appears on the published page.

You will be notified when your edited article has been posted to the PE web site,
normally before it is has been published, unless only minor changes have been
made. If the required changes are extensive or if there are significant questions, the
Editor will return your article in Microsoft Word file proofs first. However, in the
interests of speed and convenience, a lightly edited article will be uploaded to the
web site and published without your seeing proofs. Review your article immediately
when notified of its posting or publication. The Editor will not publicize your article
on Twitter or the PE home page until it has your approval.

Updating Your Article

PE articles are signed and, unlike Wikipedia articles, can be edited only by the
Editor, the article author and other authorized PE authors.

As an online publication, the PE is able to revise articles at any time so that they
remain up to date. We encourage you to review your article regularly and make both
minor and major adjustments by logging in and creating a new draft (an edited
version of the original). This may involve  correcting errors, adding new sources,
adding new sections and reworking content to respond to emerging ideas on your
topic. Notify the Editor when you are finished editing, so that your updates can be
published. Your revisions will not become public until approved and published by
the Editor. Contact the Editor if you are uncertain about how to log on to the PE site
or to access your article for editing. Alternatively, the Editor will make minor
changes at your request.

Introductory Paragraph

The introductory paragraph is the Editor’s responsibility. It is crafted not only to
summarize the main points of the article, but for search engine optimization. If you
chose to write a draft of this paragraph, keep the length under 100 words. Do not
include endnote citations or hyperlinks.

Article Body

General

There is considerable variation in punctuation, spelling of words, meanings of
words and expressions, as well as in some aspects of grammar, amongst the
regional varieties of English, especially between British and American English.[1]

The PE adopts a minimalist approach to punctuation in the article body but in
general follows British conventions, as per the New Oxford Style Manual (3rd ed) [2]

and the Oxford English Dictionary. An exception is the handling of hyphens in
compound words, where the contemporary American practice of joining many
common compounds without hyphens is preferred (see Compound Words and

https://global.oup.com/academic/authors/author-guidelines/house-style/


Hyphenation).  For more detailed guidance, see the appropriate sections below. If
you are uncertain about British usage, write in your customary style and it will be
adjusted as appropriate by the Editor.

Organize your information in sections and subsections. Avoid long and complex
sentences and keep your paragraphs short. Paragraphs should be no longer than
180 words in length; most should be no more than 160 words long. This applies to
all articles, including those (eg European Children Who Recall Previous Lives)
which are primarily lists of case summaries. For the latter, keep the summaries brief
while providing a balance of succinctness and illustrative detail. You should strive
to be both interesting and informative, to keep readers reading. Remember that you
are writing text for reading online, not in a printed work.

Remember that PE articles are written for a general readership. When using
technical language – for instance, when writing about reincarnation, the term
‘solved case’ – define it on first mention. This not only facilitates comprehension, it
can obviate misunderstanding. 

When summarizing published work, you may use either past or present tense, but
do not mix styles in the same article. When listing a series of items in your text,
precede the series with a colon, enclose in parentheses the numbers or letters that
introduce each item, and conclude each item with a semi-colon:

Pasricha notes that all informants agreed Rakesh made three correct
statements about Bithal Das’s life before visiting Tonk: (1) he had lived there;
(2) he had been a carpenter; and (3) he had been electrocuted.
A related problem with the sore thumb assumption is that there is no reason
to think: (a) that psychic functioning occurs only when parapsychologists are
trying to induce it; or (b) that we can infer either the role or the limits of
spontaneous psi from its manifestations in psychologically straitjacketed
experimental settings. 

You may also list items in bulleted lists (see Bulleted Lists).

Section Headings and Subheadings

The PE provides for two levels of headings and subheadings. Each section and
subsection should contain a distinct topic and should follow a logical or in some
instances a chronological sequence. Headings and subheadings are a good way to
organize information for the reader, and their use is encouraged.

Normally, one level of subheading under a main heading suffices, but if you need a
second level, mark the heading in bold face. Rarely, a third level is required;
it should be italicized.

Keep your headings and subheadings brief and capitalize the main words in them
(at all levels). When writing a series of related articles, try to the use the same
structure and heading/subheading names.

Commas
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Avoid over-use of commas. Commas should be employed when required for
grammatical reasons (eg with subordinate clauses or introductory phrases of more
than a few words) or for clarity of expression, but their excessive use can impede
reading online. Write,

‘Having performed the experiment, the authors concluded that …’ rather
than, ‘Having performed the experiment the authors concluded that …’.
‘In 1987, he published a book titled …’ rather than, ‘In 1987 he published a
book titled …’.

However, commas may be omitted if a sentence flows well without them and its
meaning is not affected by leaving them out:

‘In the autumn of 1937 a strange communicator began to manifest at the
regular séances Hafsteinn held in the home of Einar Kvaran in Reykjavik’ is
preferable to, ‘In the autumn of 1937, a strange communicator began to
manifest at the regular séances Hafsteinn held in the home of Einar Kvaran
in Reykjavik’.

It is not necessary to include commas after every item in a series of items (the so-
called Oxford comma) if the items consist of a few words only, but commas should
be used to separate all items in a longer or more complex series of items:

Hafsteinn was polite, punctual and orderly, making him very popular.
Ian Stevenson, who was interested in drop-in communicators, xenoglossy
(unlearned language), and other facets of Hafsteinn’s mediumship,
participated in some of Erlendur’s investigations.

When referring to multiple authors in the text (even within parentheses), use 'and'
rather than an ampersand to join the last two names and leave off  the comma
following the penultimate name.

He suggested that Gardner focused on weaker studies, pointing out that he
gave only cursory attention to two experimental reports – one by Blom and
Pratt and another by Pratt, Keil and Stevenson that Pratt considered to be the
best evidence of ESP ‘because alternative hypotheses could be rejected with
considerable confidence’.

Do not use commas between months and years. Write,

‘All new contributions from February 2021 onwards should adhere to these
rules’, not, ‘All new contributions from February, 2021, onwards should
adhere to these rules’.

Dashes

British practice regarding en and em rules differs in some respects from dashes in
American English.[3] In writing for the PE, the important difference is in the use of
the en rule (the length of two hyphens and half the length of an em rule). This may
be substituted for an em rule, as used in American English, but with a space
preceding and following it. Microsoft Word and other word processing programmes



will convert a hyphen  preceded and followed by a space to an en rule when it is
succeeded by another word. As with American dashes, en rules with spaces on
either side may be used either singly or in pairs. For example:

Focus on facts – on the background, the key studies, the controversies, and
contesting viewpoints.
When using technical language – for instance, when writing on
reincarnation, the term ‘solved case’ – define it on first mention.

Full Stops (Periods)

In keeping with the minimal punctuation of the article body, full stops (periods) are
not used with initials or abbreviations. See Personal Titles and Contractions and
Abbreviations for further guidance.

FWH Myers, not F.W.H. Myers
eg, not e.g.

Ellipses

Use ellipses only to indicate material omitted from quoted text (see Quotations).

Collective Nouns

The PE follows British rules in regards to collective nouns (eg family, company).
These may take either singular or plural verbs, depending on whether the body is
considered as a unit or if emphasis is placed on the individuals within the unit. In
American English, collective nouns are invariably thought of as a unit and  take
singular verbs.[4] Thus,

'the family are' [British], not 'the family is' [American]
'A committee was appointed', but 'The committee were unable to agree'.
[British]

Note, however, that 'data' is considered in the aggregate in British English and takes
a singular verb:

'the data is', not 'the data are'

Spelling

PE spelling follows the conventions of British English, as per the Oxford English
Dictionary and the New Oxford Style Manual.[5] Online dictionaries provide guidance
on UK English spelling. Word processing programmes such as Microsoft Word also
will check spelling according to different varieties of English. To achieve this in
Microsoft Word, first select the text to check, then go to Review > Language > Set
Proofing Language and select English (UK).   In quotations and proper names of
organizations, keep the original spelling: For example, Rhine Center, not Rhine
Centre.[6]

The most common differences in spelling between British and American English
include:

https://global.oup.com/academic/authors/author-guidelines/house-style/


programme, rather than program
behaviour, rather than behavior
sceptic, rather than skeptic
aeroplane, rather than airplane
centre, rather than center
defence, rather than defense
enrol, rather than enroll
manoeuvre, rather than maneuver
enquire, rather than inquire
kilometre, rather than kilometer
artefact, rather than artifact

When -ment is added to words that end in -dge, the final e is retained in British
English, though not in American English.[7]

judgement, rather than judgment
acknowledgement, rather than acknowledgment

Differences between British and American English regarding the doubling or not of
final consonants in certain inflected verbs is especially complex.[8] Compounding
the issue is the existence of alternative forms in British English. The PE prefers a
single ‘s’ in ‘focused’ and ‘focusing’ but follows British practice in doubling the final
consonent in many other words, for example:

totalled, totalling, rather than totaled, totaling
travelled, travelling, rather than traveled, traveling

Although both terminal -ise and -ize are acceptable in British English, the New
Oxford Style Manual prefers -ize in most circumstances.[9] This policy is adopted by
the PE.

recognize, not recognise
italicize , not italicise

An exception is words ending in -yse, which are commonly spelled with -yze in
American English, are acceptable only with -yse in British English and in the PE.

analyse, not analyze

A group of verbs that include burn, learn and spell have an orthodox form that ends
in -ed but in British English have an alternative form ending in -t. Either form is
acceptable in the PE, but the styles should not be mixed in the same article.

burned or burnt
learned or learnt
spelled or spelt

Compound Words and Hyphenation

Avoid excessive hyphenation of compound words. British English is more
conservative than American English in employing hyphens incompounds,[10] but in
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a departure from its usual policy, the PE prefers the American practice here:

interethnic, rather than inter-ethnic
preliterate, rather than pre-literate
postmortem, rather than post-mortem
northeastern, rather than north-eastern
extrasensory perception, rather than extra-sensory perception
nonlocal, rather than non-local

Write 'percent' rather than 'per cent' (although when citing figures, use the percent
sign, eg 2%).

However, if a term is customarily written with a hyphen in American as well as in
British English, the hyphen should be retained:

near-death experience, not neardeath experience
past-life memory, not pastlife memory
post-traumatic stress disorder, not posttraumatic stress disorder
cross-cultural, not crosscultural

Contractions and Abbreviations

Do not use contractions such as don’t, won’t and didn’t, except in quotations.

Use English phrases – ‘for example’, ‘that is’, ‘and so on’ – rather than
abbreviations of Latin terms – exempli gratia (eg), id est (ie), et cetera (etc) – in your
text, although you may use these abbreviations in parenthetical comments. Note
that when used in parenthetical comments, terms such as eg, ie, and etc are written
without full points, are not italicized, and are not followed by commas.

For terms whose abbreviations are well known (eg ESP, NDE), write out the term in
full on first mention and thereafter use initials. It is not necessary to supply the
initials in parentheses following this first mention for such well-known terms, but
if the terms are less well-known, supply the initials in parentheses before using
them.

Write out 'World War I' and 'World War II' on first mention, but abbreviate to 'WWI'
and 'WWII' on subsequent mentions in the same article.

Omit 'The'  at the beginning of titles of books and journals, but do not otherwise
abbreviate the titles on first mention. On subsequent mentions of the same work in
the same article, shortened forms of the title are preferred. Similarly, the names of
organizations and publications should be given in full on first mention, but may be
abbreviated on subsequent mentions. In the latter cases, indicate the abbreviations
when the names are first introduced. With books and periodicals, be sure to italicize
the abbreviation as well as the full title.

Twenty Cases Suggestive of Reincarnation, on first mention, and Twenty Cases,
on subsequent mentions
Society for Psychical Research (SPR), on first mention, and SPR, on
subsequent mentions



Journal of the American Society for Psychical Research (JASPR), on first
mention, and JASPR, on subsequent mentions

Capitalization

Capitalize only the main words of titles, subtitles and other headings. Avoid
excessive capitalization; do not capitalize words simply for emphasis. Proper names
should always be capitalized, but similar generic references should not be
capitalized. This stricture should be observed especially in relation to biographical
articles, which otherwise can come off reading like curriculum vitae.

Correct: He joined the University of Bristol as professor of psychology.
Correct: He joined the University of Bristol as Myerson Professor of
Psychology.
Incorrect: He joined the University of Bristol as Professor of Psychology

Do not capitalize 'ganzfeld' or ‘internet’.

Personal Titles

Personal titles such as Mr, Mrs and Dr and titles of respect such as Sri should be
omitted. On first mention, supply given names along with surnames, thereafter
only surnames. Initials may be used in place of full given names, but initials should
be run together, without full stops.

Leonora Piper, not Mrs Piper, on first mention; thereafter, Piper
Ian Stevenson, not Dr Ian Stevenson, on first mention; thereafter, Stevenson
FWH Myers, not F. W. H. Myers, on first mention; thereafter, Myers

‘Sir’ may be used with the given names of knighted individuals on first mention but
should be omitted thereafter. Similarly,  honorifics such as the Burmese Ma, Maung,
U and Daw may be used on first mention but should be omitted thereafter.

Sir Oliver Lodge, on first mention; thereafter, Lodge
Ma Tin Aung Myo, on first mention; thereafter, Tin Aung Myo

'Jr' and 'Sr' should follow names immediately, without commas preceding them and
without full stops following.

William George Jr, not William George, Jr.

Numbers and Fractions

In general, spell out numbers from one to nineteen;  numbers that are written as
one word, such as twenty, thirty or ninety; and round numbers of one hundred or
more that are expressed as two words, such as one hundred, five hundred, one
thousand, one million. Follow this rule with hyphenated numbers (eg  seventeen-
year hiatus) and for numbers used imprecisely, for instance, ‘about four hundred’,
‘more than five thousand’. 

However, use numerals with exact currency values, as units of measurement, to
express times of day and with statistics.  With figures of four digits or more, use



commas to separate the figure into segments of no more than three digits each:

In 2,000 trials Stepanek scored 1,144 hits where 1,000 would have been
expected by chance (57%), a highly significant result.

Express fractions in digital form, not in words, even when they include numbers
that would normally be written as words.

4.5, not four and a half

Ages

Write ages in accordance with the rules for numbers.

He was nineteen years old.
All infants had reached the age of thirty months.
She was 21 at this time.

Weights and Measures

In giving weights and measures, the PE  generally prefers metric (kilograms,
kilometres) rather than imperial (pounds, miles) terms, but imperial terms are
acceptable as an alternative. You may also supply both terms (imperial in
parentheses).

Values should follow the rules for numbers. Spell out terms (eg kilometre) rather
than using abbreviations (km) in the article body text, but use abbreviations within
parentheses (and in  endnotes). An exception is with weights of people, which in
British practice are given in stone (fourteen pounds) and pounds:

At the time, she weighed four stone, five pounds.

Statistical Expressions

Use figures, rather than words, to express numbers in statistics. Use standard
symbols such as % rather than writing these in words (per cent).

Dates

Dates should be given using the British style of day (in numeral), month (spelled
out in full) and year (in numeral), with no commas separating the elements.

13 April 2015, not April 13, 2015

Date ranges should be abbreviated, with an en rule (–), not a hyphen joining the
dates at either end:

The ETH has proved popular, despite significant criticism, and was even
suggested during the mystery airship wave of 1896–97.

Write out century names (eg twentieth century, twenty-first century). Use BCE
(Before Common Era) and CE (Common Era) rather than BC and AD. Type BCE and
CE in regular caps, not small caps.



Apart from the subject of the entry, avoid using birth and death dates for historical
individuals. This is rarely necessary and can affect the reading experience for the
general reader.

Time of Day

Time of day may be expressed in either words or figures, but the two styles should
not be mixed in the same article. Thus, both ‘half past four’ and ‘4.30’ are
acceptable, but be consistent. Use o’clock only with round hours. Also, note that
when times are expressed in figures, a full point rather than a colon (customary in
American English) is used. It is not necessary to include a full point and two zeros
(eg 4.00) when referring to round hours. Use am and pm, not AM and PM, to specify
time on a twelve-hour clock.  

He finished work on the article at half past four in the morning.
He finished work on the article at 4.30 am.
He finished work on the article at four o’clock in the morning.
He finished work on the article at 4 am.

Italics

Italics can serve a variety of purposes[11] but should be used sparingly. Avoid using
italics solely for emphasis. Be sure to italicize book and journal titles wherever they
occur. See Foreign Language Names and Terms for the use of italics with languages
other than English.

Foreign Language Names and Terms

Italicize single words, terms or short phrases in Latin and other languages other
than English (eg unus mundus, parakaya pravesh), except when these are in common
usage in English (eg et cetera, ad hominem, ad hoc, post hoc).  Except for these
standard and commonly understood foreign language terms, supply translations in
roman – not italic – as glosses in the text or in parentheses and with quotation
marks, immediately after the original. Present longer passages in translation rather
than in the original language.

It is acceptable to use translations of names of institutions, buildings  and
geographical locations. These should be in roman and not italicized.

When personal names have become standard in an anglicized  form (eg Stepanek,
Ryzl), use these forms rather than the spelling in the person's native
language (eg Štěpánek, Rýzl), but it is good form to give the latter at first mention
(perhaps in parentheses following the standard form you are adopting). When
names are generally spelled with accents in English-language publications (eg René
Sudre, Jürgen Keil), the accents should be retained in the PE.

Accented names or names spelled with unusual letters that do not have a standard
anglicized form (eg İsmail Altınkılıç, Cevriye Bayrı) should be spelled in their native
form as a rule; if exceptions are made, the native version should be given at first
mention. Difficulties may arise when names of authors are spelled without accents
in their publications. In these cases, use the accent when writing about the person,



but the unaccented form of the name when citing his work (eg Karl  Müller, but
Muller 1970).

Quotations

Most articles should include at least some direct quotations, which can be a single
phrase, a sentence or several sentences. Separate and indent longer quotes.

Following British convention, use single quotation marks, not double quotation
marks, and place punctuation (commas, semi-colons, full stops) after the end mark
rather than before it.

‘Use single quotation marks, not double quotation marks, and place
punctuation (commas, semi-colons, full stops) after the end mark rather
than before it’.

However, in quoting dialogue, place punctuation inside the closing quotation mark
rather than outside it:[12]

Once when her grandmother took her to the cemetery to put flowers on
Picciota’s grave, she protested, ‘But I am no longer there. Picciota is Irma. It
is me, and you must not cry.’ 

Use ellipses (three dots) to indicate omitted material from the quoted text. Single-
space the dots and leave a space before and after them; do not run the ellipses into
the words on either side of the omission. If the excised words follow the end of a
sentence, include the sentence's full stop, leave a space, then the three dots of the
ellipses, and another space before the quotation resumes. Similarly, if the break in
the quoted material ends with an abbreviated word that has a full stop, include the
full stop before the ellipses dots. Do not include ellipses to indicate the
continuation of the quotation, as this is implied.

We begin each life with a tabula rasa ... onto which the past impresses itself
through involuntary memories and unconscious influence on our behavior.
The usual age of forgetting seems to coincide with the increased activity of a
child outside the physical and social environment of his immediate family.
… I believe this adjustment brings new experiences, the memories of which
cover and seem to obliterate those of the previous life.
Conway, Meares et al. … propose that this is achieved by what they term
adaptive coherence.

Bulleted Lists

Bulleted lists are welcome. Use black circular bullets only, no other symbol or
numbers.

Bulleted lists may include words, sentence fragments or full sentences. If listed
items are words or sentence fragments, begin them in lower case and supply no
terminal punctuation. If listed items are sentences, begin with a capitalized initial
word and end with a full stop. Never end listed items with semi-colons.



If bulleted list items are brief, leave no line space between them. If bulleted items
are complex or extend to more than a sentence or two, enter a blank line between
them.

Source Citations

Use endnotes rather than in-text references (eg Wehrstein, 2019) or footnotes to
cite sources. Whenever possible, position endnotes at the end of sentences, clauses
or paragraphs. Use your word processor to assign the endnote number (in Microsoft
Word, position your cursor where you want the endnote number to appear, go to
References, and select ‘Insert Endnote’; alternatively, use the keyboard shortcut
Ctrl + Alt + D).

Do not use multiple endnotes at the same point. If you need to make multiple
comments but cannot spread them out, combine all comments under the same
endnote. 

In general, follow the standard academic practice of avoiding Wikipedia as a source.
However, a link to a Wikipedia entry may sometimes be useful for readers. This is
so, for instance, with historical individuals (philosophers, scientists, authors)
outside the field of parapsychology (eg Immanuel Kant, Charles Darwin) and
scientific terms (eg Bayesian, Fourier). If there is a PE article on the same subject,
however, cite it rather than the Wikipedia equivalent.

Embedded Hyperlinks

Hyperlinks to other sources on the internet – both written sources and videos – are
encouraged. Use your word processor to embed hyperlinks in your text, rather than
giving the URLs for readers to copy and enter on their own. In Microsoft Word, this
can be achieved by going to Insert > Hyperlink > Existing File or Web Page > Current
Folder and entering the URL in the field at the bottom of the box. Both headings
and subheadings of pages may be specified; the latter are useful to lead the reader
to a specific part of a text. Select the section or subsection title and copy the URL
from your browser into your document.

Tables

If you need to present data in tables, format them as you wish them to appear and
send them to the Editor in files separate from your text. Tables published elsewhere
may be reproduced within ‘fair use’ guidelines so long as they are properly credited.
Indicate where in your text you would like the tables to be inserted.

Illustrations

Illustrations other than tables  are inserted in the article body only rarely. Rather,
they are displayed in the right-hand column on the PE article page. Submit all
images for display to the Editor in individual files separate from your text
submission.

By-Line



Place your name between the body of the article and the literature list, without the
word ‘by’, and in regular type.

Biographical Articles

Biographical articles comprise a large fraction of the PE contents, so should be
well-researched and written. Unless there is reason for not doing so, they should
follow a similar structure and employ similar headings, as described below.

Birth and death dates follow the form ‘Frederic Myers (1843–1901)’ for deceased
persons and ‘James Leininger (b 1998)’ for living persons. For living subjects,
consult with the subject and send him or her a draft of your biography for review
before submitting it to the Editor.

A biographical article on a parapsychologist or psychical researcher should
emphasize the subject’s work in the field of parapsychology or psychical research,
highlighting particularly important studies, experiments, actions, theories,
accomplishments and publications. How much detail about their background and
work outside the field and personal life you include will depend on article length.
Avoid a ‘Criticisms and Controversies’ section in biographical articles on people
active in parapsychology unless the subject has made engaging in controversy part
of his or her work.

Biographical articles on people with apparent paranormal gifts should focus on
their abilities, accomplishments and major events in their paranormal careers or
practices, with strongest emphasis on any formal testing or investigation of their
abilities. Again, detail on their background and personal life will depend on article
length.

In lists of written works by the subject of a biographical article, emhasize their
parapsychological contributions.  If there are many of these, include the most
important ones, specifying that the list is select, and provide a link to a full
bibliography if available. Avoid duplicating entries that appear in the Literature
list; instead, refer the reader to the Literature list for citations.

Because each biographical subject is different, the PE does not expect total
uniformity in article structure or headings but the following is provided as a guide.
Additional sections that do not fall under any standard heading may be added as
needed, for instance, ‘After-Death Communications’ for a subject (eg William
Barrett) whose spirit associates claim to have heard from him post-mortem. For
more detailed models, see the biographies of Erlendur Haraldsson  and  Ian
Stevenson  for researchers,  Pavel Stepanek  and Hafsteinn Bjornsson for research
subjects.

Life and Career (alternatively, especially for living subjects, simply Life, or
Career)
Parapsychological Research (for researchers), Investigations (for research
subjects)
Professional Posts and Honours, or Honours and Awards
Legacy (for deceased individuals)

file:///articles/william-barrett
file:///articles/erlendur-haraldsson
file:///articles/ian-stevenson
file:///articles/pavel-stepanek
file:///articles/hafsteinn-bj%C3%B6rnsson-medium


Works, with subheadings for Books and Articles and optionally Book
Chapters; Book Reviews; Web Posts and Blogs; Lectures, Podcasts,
Videos; and Archival Collections, or similar headings, in that order
Literature

The narrative portions of article body should proceed in roughly chronological
order. Under ‘Life and Career’, discuss the subject’s early life, education, reason for
entering into the activities that make him or her notable, highpoints of their career
and other relevant background information. Under ‘Parapsychological Research’ or
‘Investigations’, provide accounts of the most important aspects of their work, with
summaries of the rest, in subsections if necessary. Under ‘Professional Posts and
Honours’ list leadership positons in professional organizations and any awards,
significant grants, fellowships, honourary degrees, honourary positions or other
recognitions received by the subject. If the subject held no professional positions,
use an alternative heading, such as ‘Honours and Awards’. Use ‘Legacy’ for
deceased subjects only; describe the lasting impact of their life’s work.

In the Works list, begin with the the title of the work, omitting the mame of the
author. Place the date of publication in parentheses following the title, with a full
stop after. If there are authors other than the subject of the biographical article,
include their names within parentheses following the date. Use a similar format for
book chapters and journal articles, with the rest of the citation following the rules
for these works. The following examples are drawn from the biography of Alan
Gauld.

The Founders of Psychical Research (1968). London: Routledge & Kegan Paul.
Poltergeists (1979, with AD Cornell). London: Routledge & Kegan Paul.
Henry Sidgwick, theism and psychical research (2007). In Henry Sidgwick -
Happiness and Religion, ed. by P. Bucolo, R. Crisp, & B. Schultz, 160-257.
Catania, Italy: Department of Human Science, University of Catania.
A series of ‘drop in’ communicators (1971). Proceedings of the Society for
Psychical Research 55, 273-40.

If book reviews are included in the Works list, place them under their own heading,
omitting 'Review of' at the start of the citation:

The New Prometheans: Faith, Science, and the Supernatural Mind in the
Victorian Fin de Siècle by C. Raia (2020). Journal of the Society for Psychical
Research 84, 157-70.

Under Web Posts and Blogs (subheading under Works) include PE articles your
subject has authored. If there are a substantial number of articles, or the subject is
still alive and active, link to the PE author's page for a list of contributions, to
obviate the need for updates as new articles are published. If there are several posts
on the same site, such as the Psi Encyclopedia, it is not necessary to give the full
source reference for each; an introductory statement followed simply by titles (with
embedded hyperlinks) and the year of initual publication (in parentheses) is
sufficient.

file:///articles/alan-gauld
http://www.henrysidgwick.com/4th-paper.1st.congress.cat.eng.html


Note that the sections of Works and Literature are distinct. The Works section
includes items authored by the subject of the article; the Literature section includes
items referenced in the article and cited in the endnotes. There may be overlap
between these sections, but try to keep it to a minimum. If you find that you need
to cite all of the subject’s works in the endnotes, do not list them under Works also
but instead add a comment directing the reader to the Literature section. You may
also wish to reference or link to bibliographies of works in other sources.

Literature List

General

In the PE, the Literature list replaces the reference list or bibliography in a printed
work. It includes works that are referenced in endnotes or embedded links but
nothing beyond this. The format of the opening segment of works in the Literature
list is similar to that of the American Psychological Association (APA), whose style
is commonly used in experimental parapsychology, in placing a publication date in
parentheses following an author’s name and in its use of initials rather than full
first names for authors. However, PE citation and reference style departs in many
respects from APA style.

Unlike in the article body, formal punctuation is used in the literature list (and in
the endnotes). Thus, initials and abbreviations are followed by full stops. In
conformance with British style, initials should be run together with no space
between them.

List sources in alphabetical order using the author’s surname, followed by initials.
Where more than one source by the same author is listed, arrange by date of
publication, if necessary adding a, b, c, and so on, to differentiate works published
in the same year by the same author. Do not substitute the author’s name with
three em dashes, but type it out again for each entry. Use block formatting (not
hanging) for each entry, with blank lines between entries.

Never precede page numbers ‘p’ or ‘pp’, with either journal citations or books, in
either the literature list or the endnotes. The initial figure or figures of page ranges
beyond the first two are elided when they are the same, thus producing 23-24, 123-
35, 1234-35. Use hyphens, not en rules, in giving page ranges.[13]

The following sections provide examples of citations for different types of work.

Book by Single Author

All the main words in the title and subtitle of books are capitalized and italicized. If
in doubt about which words to capitalize, follow the book’s title page. Include the
place of publication with book publishers. Unless the city is well known (eg London,
New York, Delhi), also provide the nation (abbreviated with UK and USA). In larger
countries, the state or province may be included to reduce ambiguity. Write out the
name of the state or province rather than using its abbreviation.



Matlock, J.G. (2019). Signs of Reincarnation: Exploring Beliefs, Cases, and
Theory. Lanham, Maryland, USA: Rowman & Littlefield.

When one volume in a multi-volume work is cited, so indicate in parentheses
following the title. If an edition later than the first edition is cited, this also should
be noted. Place the abbreviations ‘vol.’ and ‘ed.’, in lower case and within
parentheses, before the closing punctuation of the title segment of the citation.

Churchill, C.H. (1853). Mount Lebanon: A Ten Years’ Residence from 1842 to
1852 (vol. 2) (3rd ed.). London: Saunders & Otley.

When a book has been published in more than one edition, cite the edition
consulted. Optionally, include information about other editions in square brackets
in the format ‘Reprinted’ (date) ‘by’ publisher, place of publication. This may be
advisable if the most commonly available edition is other than the one cited.

McLuhan, R. (2010). Randi’s Prize: What Sceptics Say about the Paranormal,
Why They Are Wrong & Why It Matters. London: Matador. [Reprinted 2019 by
White Crow Books, Hove, UK.]

Book by Two or More Authors

Invert surnames and initials for all authors when citing multiple authors. Connect
two authors with an ampersand (&), not the word ‘and’. Connect three or more
authors with commas and an ampersand between the last two. Note that a comma
should follow the second or final author’s initials and precede the ampersand.

Haraldsson, E., & Matlock, J.G. (2016). I Saw a Light and Came Here:
Children’s Experiences of Reincarnation. Hove, UK: White Crow Books.
Rivas, T., Dirven, A., & Smit, R.H. (2016). The Self Does Not Die: Verified
Paranormal Phenomena from Near-Death Experiences. Durham, North
Carolina, USA: International Association for Near-Death Studies.

Edited Book

The citation format for edited books is the same as for single-authored books, with
‘(ed.)’ or ‘(eds.)’ following the editor’s name or editors’ names. Note that ‘ed.’ and
‘eds.’ are written in lower case, with full stops. A full stop follows the year of
publication (in parentheses), concluding the author-date segment of the citation.

Moreira-Almeida, A., & Santos, F.S. (eds.) (2012). Exploring Frontiers of the
Mind-Brain Relationship. New York: Springer.

Book Available Online

For works available online, embed hyperlinks in the titles. When a work is
composed of multiple volumes, they may be listed either as parts of the same entry
or separately, depending on how the work is cited. If the different volumes of multi-
part work have different titles or subtitles, each should be specified, either in
separate entries or within the same entry.When 'Vol.' is used as part of a subtitle, it
should be capitalized.



Prince, M. (1906). The Dissociation of a Personality:A Biographical Study in
Abnormal Psychology. London: Longmans, Green & Co.
Stevenson, I. (1997). Reincarnation and Biology: A Contribution to the Etiology
of Birthmarks and Birth Defects (2 vols.). Vol. 1: Birthmarks. Vol. 2: Birth
Defects and Other Anomalies. Westport, Connecticut, USA: Praeger.

Forthcoming Book

Use for books that have reached the editorial stage of production. If a work is at the
printer, ‘in press’ may be substituted for ‘forthcoming’.

Haraldsson, E. (forthcoming). Towards the Unknown: Memoir of a Psychical
Researcher. Hove, UK: White Crow Books.

Chapter in Book

When only one chapter of a book is cited, lower case is used for all words of the
chapter except those ordinarily capitalized. The chapter title is not italicized. The
book title is capitalized as per its title page and italicized. Editors’ names follow the
title, preceded by ‘ed. by’; surnames and initials are not inverted. Chapter page
numbers follow the editors’ names; a full stop follows the page numbers,
concluding the volume segment.

Almeder, R. (2012). The major objections from reductive materialism against
belief in the existence of Cartesian mind-brain dualism. In Exploring Frontiers
of the Mind-Brain Relationship, ed. by A. Moreira-Almeida & F.S. Santos, 17-
33. New York: Springer.
Ruickbie, L. (2013). ‘So terrible a force’: Spirit communication in the
Hermetic Order of the Golden Dawn and its relationship to Spiritualism. In
The Spiritualist Movement: Speaking with the Dead in America and Around the
World, vol. 3, ed. by C. Moreman, 101-19. Westport, Connecticut, USA:
Praeger/ABCCLIO.

When a chapter is from a book by a single author, it is not necessary to repeat the
author’s name preceding the page number. For material originally published in
another source, the original source may be indicated in square brackets as the final
element of the citation. Alternatively, the original source may be given as the
primary citation with the reprinted work as a secondary citation. The edition cited
should be the edition consulted, with the other edition indicated in square
brackets.

Andrade, H.G. (2010). A case suggestive of reincarnation. In Science and
Spirit, 135-84. London: Roundtable. [Originally published 1980 as A Case
Suggestive of Reincarnation: Jacira and Ronaldo (Monograph No. 3) by the
Brazilian Institute for Psychobiophysical Research, São Paulo.]

Paper in Academic Journal

Use for papers in printed journals. For open-access publications, see Open-Access
Journal Paper.

https://ia802605.us.archive.org/3/items/dissociationofpe00priniala/dissociationofpe00priniala.pdf
https://archive.org/details/reincarnationandbiology01?q=reincarnation+biology+stevenson
https://archive.org/details/reincarnationandbiology02?q=reincarnation+biology+stevenson


Journal volume numbers are not italicized and are not separated from the journal
name by commas. Issue numbers are optional, but when supplied, are separated
from volume numbers by a solidus (slash), then a comma and the page numbers.
When there are multiple authors, follow the style used for books with multiple
authors in the author segment of the citation.

Rosenzweig, S. (1987). Sally Beauchamp’s career: A psychoarchaeological key
to Morton Prince’s classic case of multiple personality. Genetic, Social, and
General Psychology Monographs 113/1, 5-60.

If the cited paper has been reprinted in a book, that book’s bibliographic
information may be given in square brackets following the main citation. The book
title is preceded by the phrase ‘Reprinted in’ and the publication date follows the
book title and date of publication in parentheses, if the book is a collection of
papers by the same author as the paper. If the paper is by another author or it is
written jointly, for clarity's sake it is necessary to give the main author's name as
author of the book. If the paper is reprinted in a book edited by another auther,
indicate that it is 'ed. by' that author. The paper's page numbers in the book come at
the end of the segment, which is closed by a full stop.

Pasricha, S.K. (1983). New information favoring a paranormal interpretation
in the case of Rakesh Gaur. European Journal of Parapsychology 5, 77-85.
[Reprinted 2008 in Can the Mind Survive Beyond Death? In Pursuit of Scientific
Evidence, Vol. I: Reincarnation Research, 271-81.New Delhi: Harman
Publishing House.]
Pasricha, S.K., & Barker, D.R. (1981). A case of the reincarnation type in
India: The case of Rakesh Gaur. European Journal of Parapsychology 3, 381-
408. [Reprinted 2008 in Can the Mind Survive Beyond Death? In Pursuit of
Scientific Evidence. Vol. I: Reincarnation Research by S.K. Pasricha, 237–69.
New Delhi: Harman Publishing House.]

Minor Item in Academic Journal

Use for book reviews, letters to the editor, editorials and untitled matter.

Rhine, L.E. (1966). Review of Twenty Cases Suggestive of Reincarnation by I.
Stevenson. Journal of Parapsychology 30, 263-72.
Rogo, D.S. (1986). Letter to the Editor. Journal of the Society for Psychical
Research 53/805, 468-71.
Stevenson, I. (1986). Comments by Ian Stevenson. Journal of the Society for
Psychical Research 53/802, 232-39.

Open-Access Journal Paper

Use for publication in open-access academic journals published originally online.
Embed a hyperlink to the piece in its title.

Irwin, L. (2017). Reincarnation in America: A brief history. Religions 8/10.
Bierman, D.J., Spottiswoode, J.P., & Bijl, A. (2016). Testing for questionable
research practices in a meta-analysis: An example from experimental
parapsychology. PLoS One (May 4) 11/5.

https://www.mdpi.com/2077-1444/8/10/222
https://pubmed.ncbi.nlm.nih.gov/27144889/


Any 'doi' number, as in the example below, should be deleted. Instances in existing
entries will be edited accordingly.

Bierman, D.J., Spottiswoode, J.P. & Bijl, A. (2016). Testing for questionable research
practices in a meta-analysis: An example from experimental parapsychology. PLoS
ONE. 2016;11(5):e0153049. doi:10.1371/journal.pone.0153049.

Article in Scholarly Magazine

Use for periodicals such as Parapsychology Review, Paranormal Review, EdgeScience
 and the ASPR Newsletter, that are scholarly, yet not fully academic journals. Also
use for sceptical publications such as Skeptical Inquirer.

Citations of scholarly magazines are distinguished from academic journals by
inclusion of month of publication. The month is placed in parentheses following
the volume number; abbreviate longer months according to standard rules and
include full stops, for instance, Feb., Dec. Join spans of months with a hyphen. If
there is an issue number, this may be included as well, with a solidus (slash)
following the volume number, as with academic journals.

Ruickbie, L. (2014). A vision in Bermondsey, 1917: A previously unreported
First World War anomalous experience. Paranormal Review 71 (July), 28-29.
Nicol, J.F. (1976). Review of Cases of the Reincarnation Type. Volume I: Ten
Cases in India by I. Stevenson. Parapsychology Review 7/5 (Sept.-Oct.), 12-15.
Stevenson, I. (1995). Empirical evidence for reincarnation?  A response to
Leonard Angel. Skeptical Inquirer 19 (May-June), 50-51.

Article in General Interest Publication

Use for articles that originally appeared in print. For articles whose original
publication was on the internet, see Online Article or Blog Post.

The reference format for an article in a mainstream general-interest magazine
differs from APA style in the placement of the day and month of publication after
the publication name in the final segment of the citation, rather than following the
year. Use standard abbreviations for longer months. If page numbers are known,
place them following the day and month of the publication. If the article is
available on the internet, embed the hyperlink in its title. If the article was
obtained from a database such as the Internet Archive, this may be noted as the
final element of the citation.

Dart, J. (1986). Skeptics’ revelations: Faith healer receives ‘heavenly’
messages via electronic receiver, debunkers charge. Los Angeles Times, 11
May.
Higginbotham, A. (2014). The unbelievable skepticism of the Amazing Randi.
New York Times Magazine, 7 November. Archived on the Internet Archive.
Stevenson, I. (1959). The uncomfortable facts about extrasensory perception.
Harper’s Magazine, 1 July, 19-25.  

Master’s or Doctoral Thesis

file:///H:/Psi%20Encyclopedia/Style%20Guide/archive.org
https://www.latimes.com/archives/la-xpm-1986-05-11-me-5518-story.html
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Indicate whether the reference is to a doctoral (PhD), Master’s (MA), or other type
of thesis submitted for an academic degree. Thesis title is italicized, as if it were a
book. Indicate the degree-granting institution in square brackets. If the thesis is
available through University Microfilms International or other provider, so
stipulate. If it is available online, embed the hyperlink in the title.

Sommer, A. (2013). Crossing the Boundaries of Mind and Body: Psychical
Research and the Origins of Modern Psychology. [PhD thesis, University
College, London.]
Davis, W.D. (1971). Societal Complexity and the Nature of Primitive Man’s
Conception of the Supernatural. [PhD thesis, University of North Carolina,
Chapel Hill.] University Microfilms International.
Matlock, J.G. (1993). A Cross-Cultural Study of Reincarnation Ideologies and
their Social Correlates. [MA thesis, Hunter College, City University of New
York.]

Unpublished Conference Paper

For unpublished conference papers, give the year in parentheses following the
author’s name. Follow the title with the phrase ‘Paper presented at’ and the name,
location and date (day and month) of the meeting. Note the number of the meeting
in numeral rather than spelling it out (eg 3rd rather than Third) and that an en rule
is used in giving the date span  of the meeting. If the paper is available online,
embed the hyperlink in its title.

Ruickbie, L. (2019). What the maid saw: A case of remote viewing during the
First World War. Paper pressented at the 43rd International Annual
Conference of the Society for Psychical Research, Leicester, UK, 20–22
September.
Matlock, J.G. (2015). Evidence of past-life memory in a mildly autistic boy.
Paper presented at the 3rd Annual Meeting of the Lithuanian Society for the
Study of Religions, Vilnius, Lithuania, 22–23 October.

When the paper is included in an otherwise unpublished volume of conference
proceedings, cite it according to the following format:

Dalton, K. (1997). Exploring the links: Creativity and psi in the ganzfeld.
In Proceedings of Presented Papers, Parapsychological Association 40th
Annual Convention, Brighton, UK, 7–10 August, 119-34.

Unpublished Manuscript

Unpublished manuscripts should be avoided but may be used if their credibility is
not in question or if they are available online and publicly accessible. If the
manuscript is undated, give its date as ‘n.d.’. If it is available online, embed a
hyperlink in the title. Follow the title with ‘Unpublished manuscript’ in square
brackets.

Haraldsson, E. (n.d.). The medium Hafsteinn Björnsson. [Unpublished
manuscript.]

file:///H:/Psi%20Encyclopedia/Style%20Guide/).%20A%20Cross-Cultural%20Study%20of%20Reincarnation%20Ideologies%20and%20their%20Social%20Correlates
http://jamesgmatlock.com/wp-content/uploads/2015/11/Past-Life-Memory-in-a-Milldy-Autistic-Boy1.pdf


Online Article or Blog Post

Use for articles whose original publication was online, on web sites or blogs. For
academic papers in online open-access publications, see Open-Access Journal
Paper. For articles originally published in print, see appropriate category above.

For web site sources, including the PE, use year of creation as citation date; do
not  include day and month along with year. If the creation date is not given, use
‘n.d.’ as the date. Embed hyperlinks in the article title. If the article was published
on a web site, note this following its title. Italicize the web site name. Follow by the
description ‘Web page’ in square brackets. If article was on a personal web site,
omit name of site. If the article appears in a named blog, give the blog name in
italics, followed by ‘Blog post’ in square brackets. When information is available,
note the date last updated at the time of consultation.

Anderson, R. (2013). Pan Am Flight 759 crash. Know Louisiana: The Digital
Encyclopedia of Louisiana and Home of Louisiana Cultural Vistas. [Web page.]
Barros, J.C.S. (2004). Another look at the Imad Elawar case: A review of
Leonard Angel’s critique of this ‘past life memory case study’. [Web page, last
modified 5 September 2012.]
Wehrstein, K.M. (2017). Adult past-life memories research. Psi Encyclopedia.
[Web page, last updated 18 November 2020.]

For Wikipedia articles and other posts without credited authors, treat the title as
the author, embedding a hyperlink in the title. Note the date (year) of original
creation and the date last updated at the time of consultation. (These dates may be
ascertained on the ‘View history’ tab on the Wikipedia article page.)[14] 

History of Freemasonry (2003). Wikipedia. [Web page, last updated 4 January
2021.] 

When dates of creation or last updating are supplied, it is not necessary to give the
date ‘retrieved on’ or ‘accessed on’; the date last updated serves to show which
version of a page was accessed. If no dates are given for the creation or updating of
the page, it is good form to give the date accessed, although this is not mandatory.

Film or Video

For films and videos, use as author the producer’s name or if this is not given, the
name of the producing organization. Follow with year of production in parentheses
and title in italics. The last element, in square brackets, begins with a
characterization of the item. This is followed, after a comma, by other details,
optionally including date accessed or retrieved. If the item is accessible over the
internet, embed the URL in the title.

Anderson, R. (2012). Pan Am Flight 759. [Documentary film, Royd Anderson
Productions.]
Center for Inquiry (2017). A Conversation with James Randi. [YouTube post.]

Personal Communication

https://www.knowlouisiana.org/entry/pan-am-flight-759-crash
https://www.knowlouisiana.org/entry/pan-am-flight-759-crash
http://www.criticandokardec.com.br/imad_elawar_revisited.html
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https://www.youtube.com/watch?v=DZQNuw2jjzg&t=1s


Personal communications should not be included in the literature list. Instead,
reference them in endnotes.

Endnotes (References) Style

General

The chief function of PE endnotes  is to give references to works cited in the
literature list, although endnotes may be used to add substantive comments as well.

Endnote numbering is auto-generated when an insertion point is marked in the
article body. Numbering will adjust automatically when new endnotes are inserted;
you are not responsible for numbering endnotes. Note that on the published PE
page, the endnotes are headed References.

Formal punctuation (full stops) is employed with endnotes, as in the literature list.

References

The basic format of the source citations is simple: Author (publication date), page
numbers of specific passage cited, closing full stop. As with page numbers in the
literature list, elide repeated digits after the second digit at the beginning of a page
range – although if the second digit is 0, that too may be elided. Indicate page
ranges with hyphens rather than en rules.

When a citation is to two authors, join them with an ampersand; for three or more
authors, cite the first only and follow with 'et al.'.

Wehrstein (2019), 6.
Haraldsson & Matlock (2016), 212-23.
Stevenson et al. (1988).

When citing a specific volume or book that is referenced as part of a multi-
volume  work, note the volume or book number preceding the page number, as
follows:

Stevenson (1997), vol. 1, 1142.

When citing an entire chapter, rather than page numbers, indicate the chapter
number, introduced by 'chap.' or 'chaps.':

Stevenson (1997), vol. 1, chaps. 1-3.

Footnotes should be referenced as follows:

Stevenson (2001), 284 n3.
Wortabet (1860), 308-9n.

If several references are cited in the same endnote, separate them by semicolons:

See e.g. Delanne (1924); Lancelin (1922); Rochas (1911); Shirley (1936).
Tucker & Keil (2013), 280; Stevenson (1997), vol. 1, 877.



When giving references in sentences, include page numbers within parentheses
along with date of publication. If the author is included along with the publication
date, separate the author’s name and the publication date with a comma.

Andrade (2010). Summaries are given by Playfair (2011, 169-71) and by
Haraldsson & Matlock (2016, 204-8).
Materialism is under assault from philosophy (e.g., Koons & Bealer, 2010),
psychology (e.g., Barušs & Mossbridge, 2017), neuroscience (e.g., Wollacott,
2015), quantum mechanics (e.g., Stapp, 2011) and other disciplines (e.g.,
Kastrup, 2014; Kelly, Crabtree, & Marshall, 2015).

Substantive Comments

Endnotes may be composed entirely or partially of substantive comments.
Comments that supply significant information should include a reference to a work
included in the literature list.

In endnotes, use abbreviations such as e.g., i.e., etc., rather than phrases such as
‘for example’, ‘that is’, ‘and so forth’. Normally, e.g. and i.e. should be followed by
commas. Use figures for numbers, rather than writing them out.

For personal communications, cite the person from whom the communication case
and the date of the communication. It is not necessary to specify the nature of the
communication (in email, verbal communication, etc).

Hyperlinks

Hyperlinks may be embedded in endnotes using the reference date as the linked
text. To direct the reader to a particular section of an online article, include the
section title and make it part of the linked text.

Fuller (1974).
Matlock, J.G. (2020, Cross-Cultural Comparisons).

Citing items in endnotes not included in the reference list is acceptable, provided
that hyperlinks to pages posted online are included. The hyperlinks maybe
embedded either in words or in URLs:

See Nýr styrktarsjóður við Háskóla Íslands - Styrktarsjóður Erlendar
Haraldssonar (4 November 2010) and Styrktarsjóður Erlendar Haraldssonar (8
August 2013).
See https://notendur.hi.is/erlendur/english/svid.htm#5 for a full list of
Erlendur's publications in experimental parapsychology. 

James G Matlock, Robert McLuhan, and KM Wehrstein

Literature

American Psychological Association  (2020). Publication Manual of the American
Psychological Association (7th ed.). Washington, D.C., USA:American Psychological
Association.

http://www.nybooks.com/articles/1974/07/18/trick-or-treatment/
file:///articles/european-children-who-recall-previous-lives#Cross-Cultural_Comparisons
http://www.sjodir.hi.is/nyr_styrktarsjodur_vid_haskola_islands_styrktarsjodur_erlendar_haraldssonar
http://sjodir.hi.is/styrktarsjodur_erlendar_haraldssonar
https://notendur.hi.is/erlendur/english/svid.htm#5


Oxford University Press  (2016). New Oxford Style Manual (3rd ed.). Oxford, UK:
Oxford University Press.

Endnotes

Footnotes

1.ˆ Oxford University Press (2016), 407-22.
2.ˆ Oxford University Press (2016).
3.ˆ Oxford University Press (2016), 86-88.
4.ˆ On this and other grammatical differences between American and British
English, see this Wikipedia article.
5.ˆ Oxford University Press (2016), 49, 411-12
6.ˆ If you do not yet have the English (UK) dictionary installed, go to Review >
Spelling and Grammar > Options > Language > Add additional languages, and
select English (UK) from the drop-down list.
7.ˆ Oxford University Press (2016), 51.
8.ˆ Oxford University Press (2016), 52-54.
9.ˆ Oxford University Press (2016), 49-50.
10.ˆ Oxford University Press (2016), 413.
11.ˆ Oxford University Press (2016), 128-32.
12.ˆ Oxford University Press (2016), 164-65.
13.ˆ Technically, an en rule (–) should be used with page ranges, but since
most word processing programs do not insert it automatically, and it is time-
consuming to correct in editing, the PE employs hyphens instead.
14.ˆ As the APA Publication Manual points out in its 7th edition, because
Wikipedia pages are archived, this date allows interested readers to bring up
the version of the page you consulted (American Psychological Association,
2020, 290).
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